
CCCCoCoCoCoCoCoCoCo ttntntntntntntntntenenenenenenenentttstststststststs

ImageBrowser EX 
User Guide

CEL-SS4RA210

ImageBrowser EX 
CameraWindow



2CCCCoCoCoCoCoCoCoCo ttntntntntntntntntenenenenenenenentttstststststststs

Advanced Operations Appendix
More Advanced 

Operations
Introduction Basic Operations

Manual Conventions and Navigation

 Conventions in This Manual
The following labels are used to distinguish sections in this manual:

Indicates operations in Windows environments.

Indicates operations in Macintosh environments.
Windows operations are used in some cases to illustrate instructions in this manual. The 
Macintosh equivalent for [Ctrl] is [command] and for [Enter] is [return].
Screenshots in explanations are mainly from Windows. Some screen elements may be dif-
ferent in Macintosh environments.

Indicates operating precautions that should be followed, or important information to 
note. Be sure to read these sections.

Indicates operating tips and convenient ways to use the software. Read these sections as 
needed.

Windows

Macintosh

Conventions in This Manual

Manual Navigation

Supported Operating Environments

System Requirements



3CCCCoCoCoCoCoCoCoCo ttntntntntntntntntenenenenenenenentttstststststststs

Advanced Operations Appendix
More Advanced 

Operations
Introduction Basic Operations

 Manual Navigation
•  Click tabs or buttons to access other pages.

Tabs
Click a tab on the top of the page to access the first page in that section.

Buttons
Navigation is also possible by clicking the buttons on the bottom of the page.

Jump to the table of contents (p. 7).

Return to the page shown before you 
clicked the link.

Jump to the previous page.

Jump to the next page.

1

2

3

4

1 2 3 4

• Click links to access other pages.
  Click links in the manual shown in blue, such as “XXXXX” or (p. XX), to access the page men-

tioned.

 Supported Operating Environments
• Windows 7 and Mac OS X 10.6 screenshots and procedures are used to illustrate instructions 

in this manual. If you are using another version of operating system, the actual screens and 
procedures may be different.

• Screens and procedures may also vary depending on the model of camera/camcorder, and not 
all functions may be available, as noted in relevant sections of this manual.

• Use the software when online to take advantage of auto updating. Note that auto updating is 
not available when offline, which will prevent you from obtaining any new functions that are 
released.
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 System Requirements

Windows
Operating System Windows 7 SP1 (Windows 7 SP1 only required for wireless connections*1)

Windows Vista SP2
Windows XP SP3

Computer Computer running one of the above operating systems (preinstalled), with an included 
USB port; Internet connection required for auto updating

CPU (Still Images) 1.6 GHz or higher
CPU (Movies) HD (720p), SD: Core 2 Duo 1.66 GHz or higher

Full HD (1080p): Core 2 Duo 2.6 GHz or higher
ALL-I, IPB: Core 2 Duo 3.0 GHz or higher

RAM (Still Images) Windows 7 (64-bit): 2 GB or more
Windows 7 (32-bit): 1 GB or more
Windows Vista (64-bit, 32-bit): 1 GB or more
Windows XP: 1 GB or more (512 MB or more*2)

RAM (Movies) HD (720p), SD: 1 GB or more
Full HD (1080p): 2 GB or more

Interface USB and wireless LAN*1

Free Hard Disk Space*3 640 MB or more (440 MB or more*2)
Display 1,024 x 768 resolution or higher

*1 Connections via wireless LAN require compatible computers.
*2 On computers that cannot run Digital Photo Professional.
*3  In Windows XP, Microsoft .NET Framework 3.0 or later (max. 500 MB) must be installed. Installation may take some time, 

depending on computer performance.

Macintosh
Operating System OS X 10.6 or 10.7 (OS X 10.6.8 or later required for wireless connections*1)
Computer Computer running one of the above operating systems (preinstalled), with an included 

USB port; Internet connection required for auto updating
CPU (Still Images) 10.6: Core Duo 1.83 GHz or higher

10.7: Core 2 Duo or higher
CPU (Movies) HD (720p) or SD: Core Duo 1.83 GHz or higher in 10.6, or Core 2 Duo or higher in 10.7

Full HD (1080p): Core 2 Duo 2.6 GHz or higher
ALL-I, IPB: Core 2 Duo 3.0 GHz or higher

RAM (Still Images) 10.6: 1 GB or more
10.7: 2 GB or more

RAM (Movies) HD (720p) or SD: 1 GB or more in 10.6, or 2 GB or more in 10.7
Full HD (1080p): 2 GB or more

Interface USB and wireless LAN*1

Free Hard Disk Space*3 750 MB or more (550 MB or more*2)
Display 1,024 x 768 resolution or higher

*1 Connections via wireless LAN require compatible computers.
*2 On computers that cannot run Digital Photo Professional.
*3  Silverlight 4 or later (max. 100 MB) must be installed. Installation may therefore take some time, depending on computer 

performance.

For the latest compatibility information, including supported OS versions, visit the Canon web-
site. 
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Software Described in This Manual

 CameraWindow and ImageBrowser EX
Using mainly the following two programs, you can import images and manage them on your 
computer.

CameraWindow

CameraWindow interacts with a connected camera/
camcorder, enabling the following tasks:

• Import images from the camera/camcorder

• Return images to the camera (camcorder: still images 
only)

• Organize images on the camera/camcorder

•  EOS camera users: Use EOS Utility for these operations. (Also refer to the EOS Utility Instruction Manual, 
provided in PDF format.)

• Versions of EOS Utility before 2.10 are not compatible with ImageBrowser EX.

CameraWindow and ImageBrowser EX
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ImageBrowser EX

Use this program to manage images imported 
to your computer.

With ImageBrowser EX, you can browse, edit, 
and print images on your computer.

Once you import images from your camera/
camcorder and close CameraWindow, the 
main ImageBrowser EX window on the left is 
displayed.

You can also start the program as follows:
• Double-click the desktop icon.
• In the taskbar, click the [Start] menu → [All Programs] → [Canon Utilities] → 

[ImageBrowser EX] → [ImageBrowser EX] icon.

Windows

You can also start the program as follows:
• Click the [ImageBrowser EX] Dock icon.
• Navigate to the [Applications] folder → [Canon Utilities] folder → 

[ImageBrowser EX] folder and double-click the [ImageBrowser EX] icon.

Macintosh

• Do not use operating system utilities or other software to move, delete, or 
rename folders registered in ImageBrowser EX (or images in these folders) while 
ImageBrowser EX is in use.

• To view which folders are registered in ImageBrowser EX, see “Configuring 
Preference Settings”. 

Accessing Help
Depending on the screen, a Help button (  ) or menu is displayed. Click for instructions or a 
description of screen elements.
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 Importing Images

 Camera/Camcorder–Computer Connection Precautions
• When connecting the camera/camcorder to a computer via an interface cable, connect the 

interface cable directly to the USB port. Connection via a USB hub may prevent correct opera-
tion.

• Using other USB devices (except USB mouse devices or keyboards) when the camera/cam-
corder is connected may prevent correct operation. In this case, disconnect the other devices 
from the computer and reconnect the camera/camcorder.

• Do not connect multiple cameras or camcorders to a single computer. This may prevent cor-
rect camera/camcorder operation.

• Do not allow the computer to enter sleep (or standby) mode while a camera/camcorder is con-
nected via an interface cable. If this does happen, leave the interface cable connected to the 
computer and try to wake the computer while the camera is still connected. Some computers 
may not recover from sleep correctly if the interface cable is disconnected while they are in 
sleep mode. For details on sleep or standby mode, refer to the computer user manual.

• Do not disconnect your camera/camcorder from the computer while the CameraWindow (or 
EOS Utility) screen is displayed.

• When connecting a battery-powered camera/camcorder to the computer, make sure 
the device is fully charged, or use an AC adapter kit or a compact power adapter 
(may be sold separately, depending on your model).

• When connecting an AA battery-powered camera/camcorder to the computer, use 
batteries with sufficient charge, optional fully charged AA NiMH batteries, or an 
optional compact power adapter.

• For connection instructions, refer to the camera/camcorder user guide. For connec-
tion precautions, see “Camera/Camcorder–Computer Connection Precautions”.

Camera/Camcorder–Computer Connection Precautions

Wireless Features

Non-EOS Cameras: Importing Images with CameraWindow

EOS Cameras Only: Importing Images with EOS Utility
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  Wireless Features
As described below, some CameraWindow functions may not be available over a wireless con-
nection, depending on the operating system.
• For details on wireless LAN features, refer to the Wireless LAN Guide. (Cameras supporting wireless networking 

only.)

Operating System
Functions Windows Macintosh

Movie preview display × ×

My Camera { ×

Editing the camera owner name { ×

Returning images to the camera/camcorder { ×

Sending personal information { ×

Setting up linkage with CANON iMAGE 
GATEWAY { ×

  Non-EOS Cameras: Importing Images with CameraWindow
Connect your camera/camcorder to the computer and import images as follows:
• Instructions in this ImageBrowser EX User Guide apply when the program has been installed correctly. For instal-

lation instructions, refer to the camera/camcorder user guide.

Connect your camera/camcorder to 
the computer via the included inter-
face cable.

Start CameraWindow.
Æ  Turn the camera/camcorder on and 

prepare it for communication with 
the computer.

• After the first time you connect the camera/
camcorder to the computer via the included 
interface cable, CameraWindow will start up 
automatically.

1

2
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Camera
Follow these steps.

1. In the taskbar, click  .

2. After the screen on the left is displayed, 
click the  icon to change the program.

3. Select [Downloads Images From Canon 
Camera using Canon CameraWindow], 
and then click [OK].

4. Double-click  .

• On the screen on the left, double-click [Change 
general settings]. You can now adjust the set-
tings so that whenever the camera/camcorder 
and computer are ready for communication, 
CameraWindow will start up automatically.

Windows Vista
On the screen displayed, select [Downloads 
Images From Canon Camera using Canon 
CameraWindow].

Windows XP
On the screen displayed, select [Canon 
CameraWindow], and then click [OK].

Whenever the camera and com-
puter are ready for communication, 
CameraWindow will start up.

Camcorder

Select [Canon CameraWindow] 
and click [OK].
• Windows XP/Windows Vista: 

When the [AutoPlay] window 
appears, click [Downloads 
Images From Canon Camera 
using Canon CameraWindow].

• If a camcorder and memory 
card reader are connected at 
the same time, a dialog appears 
allowing you to select the cam-
corder model. Confirm that 
[Canon Camera] or your cam-
corder model name is displayed 
and click [OK].

Whenever the camcorder and com-
puter are ready for communication, 
CameraWindow will start up.

Windows

Macintosh

Windows

Macintosh
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Click [Import Images from Camera], 
and then click [Import Untransferred 
Images].
• Only images that you have not transferred to 

the computer will be imported.

• If you have used the GPS logger function, log 
files will also be imported.

 Click [OK] on the screen displayed 
after importing, and then close 
CameraWindow.
Imported images are now shown in the main 
ImageBrowser EX window.
• On initial ImageBrowser EX startup, a screen 

is displayed for specifying where to save 
imported images. Follow the instructions dis-
played to choose the destination folder.

• Importing problems may occur if there are 
too many images (more than 1,000) on the 
memory card. In this case, use a memory card 
reader to import the images. For instructions 
on importing images from a memory card 
reader, see “Importing Images from Memory 
Cards”.

• Movies take longer to import, due to the 
larger file size.

Turn the camera/camcorder off.

• Importing movies using built-in Windows 7 import functions may prevent them 
from being shown in ImageBrowser EX. Instead, use CameraWindow for importing.

• CameraWindow may not start up in some versions of Windows, even when you 
connect your camera/camcorder. In this case, click the [Start] menu and select [All 
Programs] Æ [Canon Utilities] Æ [CameraWindow] Æ [CameraWindow].

• If CameraWindow does not start up even when you connect your camera, click the 
[CameraWindow] Dock icon.

3

4

5

Windows

Macintosh
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  EOS Cameras Only: Importing Images with EOS Utility
Connect your EOS camera to the computer and import images as follows:
• These instructions apply when EOS Utility has been installed correctly.

• For further details, refer to the EOS Utility Instruction Manual (provided in PDF format).

Connect your camera to the com-
puter via the included interface cable.

Turn the camera on and start EOS 
Utility.

Follow these steps.

1. In the taskbar, click  .

2. When the screen on the left is displayed, 
double-click  .

• On the screen on the left, double-click 
[Change general settings]. You can now 
adjust the settings so that whenever the 
camera and computer are ready for communi-
cation, EOS Utility will start up automatically.

Whenever the camera and com-
puter are ready for communication, 
EOS Utility will start up.

Configure EOS Utility so that 
ImageBrowser EX starts up after 
image importing.

1. On the EOS Utility menu screen, click 
[Preferences].

2. On the [Linked Software] tab, select 
[ImageBrowser EX] in [Software to link] 
and click [OK].

Click [Starts to download images].
Imported images are now shown in the main 
ImageBrowser EX window.
• On initial ImageBrowser EX startup, a screen 

is displayed for specifying where to save 
imported images. Follow the instructions 
displayed to choose the destination folder 

(p. 11).

Click [Quit] to exit EOS Utility, and 
then turn the camera off. 

1

2

Windows

Macintosh

3

4

5
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Basic Operations in CameraWindow/EOS Utility

 Basic Operations in CameraWindow
This program is designed for cameras/camcorders other than EOS cameras.
The following screen is displayed when you connect your camera/camcorder to the computer.
Click a button to see available options.

Information about memory cards or internal 
memory in the camera/camcorder

Information about the camera/camcorder

Start the process of importing camera/camcorder 
images to the computer.

Start the process of protecting, rotating, or delet-
ing camera/camcorder images. You can also return 
images on the computer to your camera/camcorder.

Start the process of uploading camera/camcorder 
movies to video-sharing websites.

Used for configuring camera/camcorder settings. 
Configurable settings include: 
•  My Camera: Changing the Shutter Sound and 

Startup Screen
• Registering Face ID Information (p. 44)
• Configuring Sharing Websites

1

2

3

4

5

6

Menu Screen

• The buttons shown vary depending on camera/camcorder model.

1 2

3

4

5

6

Customizing CameraWindow Operation
Access program preferences by clicking the  button in the upper right of the screen. On this 
screen, you can change the startup screen, automatic importing settings, the destination folder 
for saving images, and other settings to make CameraWindow easier to use.

 Basic Operations in EOS Utility
This program is designed for EOS cameras.
For detailed instructions, refer to the EOS Utility Instruction Manual (provided in PDF format). 
Versions of EOS Utility before 2.10 are not compatible with ImageBrowser EX.

Basic Operations in CameraWindow

Basic Operations in EOS Utility

Other Uses of CameraWindow
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 Other Uses of CameraWindow

Automatically Importing Images on CameraWindow Startup
Set up CameraWindow to import images automatically on program startup as follows:

Click  in the upper right of the 
screen to access CameraWindow 
preferences, and then click [Import].

On the [Auto Import] tab, choose 
[Start importing images automati-
cally when this software is launched].

 Changing the Destination Folder
• By default, images imported using CameraWindow are saved in either the [Pictures] or [My Pictures] folder in 

Windows or in the [Pictures] folder on Macintosh computers.

Click  in the upper right of the 
screen to access CameraWindow 
preferences, and then click [Import].

On the [Folder Settings] tab, click 
[Browse], and then specify the desti-
nation on the next screen.

Changing the Program Launched after Import

Click  in the upper right of the 
screen to access CameraWindow 
preferences, and then click [Import].

On the [After Import] tab, click  
and choose the program to start after 
image importing.

1

2

1

2

1

2
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Editing the Camera Owner Name
Edit the owner name for the connected camera as follows:

Click  in the upper right of the 
screen to access CameraWindow 
preferences, and then click [Camera].

On the [Set] tab, click [Edit] and enter 
the new name in the box.

 Importing Selected Images
To access the screen for choosing images to import, click [Import Images from Camera] on the 
menu screen, and then click [Select Images to Import]. Select images to import and click  
[Import] to start importing the images to your computer.

Return to the menu screen.

Images on the camera/cam-
corder that match the conditions 
you select here are shown on 
the right.

Show/hide the shooting date/
time and file name below 
thumbnails (in thumbnail display 
mode).

Change thumbnail size (in 
thumbnail display mode).

Switch display modes.

   Thumbnail display

  Preview display
   Double-clicking an image 

will also switch to preview 
display.

  Full-screen display

1

2

3

4

5

Viewer Window (Thumbnail Display)

Select all images.

Clear image selection.

Import selected images to the computer.

9

10

11

Indicates that the image has not been imported yet.

Show selected images against a blue background.

Rotate selected images 90° left or right.

6

7

8

• The buttons shown vary depending on camera/camcorder model.

1 3 4 5

62

8

7

9 10 11

1

2
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Importing All Images
Import all camera/camcorder images as follows:

On the menu screen, click [Import 
Images from Camera], and then click 
[Import All Images].

  Importing Images from Memory Cards
ImageBrowser EX is used to import images from memory cards. You can use this program with 
EOS cameras as well as other cameras/camcorders.

First, insert the memory card in the 
memory card reader.

When a screen is displayed for 
selecting an action, choose [View/
Download Images using Canon 
ImageBrowser EX]. ImageBrowser 
EX now starts up, and the screen 
on the left is displayed.

When you insert a memory card 
in the memory card reader, 
ImageBrowser EX starts up and the 
window on the left is displayed.

Use this screen for import operations.

1

2

3 4

Import all images.

Import your selected images.

Choose the destination and configure other 
settings.

Exit importing.

1

2

3

4

Windows

Macintosh
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 Organizing Images on the Camera
To access the screen for organizing images on cameras/camcorders, click [Organize Images on 
Camera] on the CameraWindow menu screen, and then click [Organize Images]. You can view 
thumbnails of the images in each folder by selecting the desired folder in the area on the left. 
The thumbnails are shown in the area on the right.

Return to the menu screen.

Images on the camera/cam-
corder that match the conditions 
you select here are shown on 
the right.

Show/hide the shooting date/
time and file name below 
thumbnails (in thumbnail display 
mode).

Change thumbnail size (in 
thumbnail display mode).

Switch display modes.

   Thumbnail display

  Preview display
   Double-clicking an image 

will also switch to preview 
display.

  Full-screen display

1

2

3

4

5

Indicates that the image has not been imported yet.

Show selected images against a blue background.

Rotate selected images 90° left or right.

6

7

8

Return images on the computer to your camera/
camcorder.

Protect selected images, or cancel protection.

Delete selected images.

9

10

11

Viewer Window (Thumbnail Display)

• The buttons shown vary depending on camera/camcorder model.

1 3 4 5

62

8

7

9 10 11

Clicking  [Delete] will delete the selected images from your camera/camcorder. Be 
careful when deleting images, because deleted images cannot be restored.
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  Returning Images to the Camera/Camcorder (Non-EOS Cameras)
Images imported to the computer can also be returned to your camera/camcorder.
This is convenient when you want to show your favorite images to friends, or when viewing 
images on the larger screen of a television.

Connect your camera/cam-
corder to the computer to access 
CameraWindow.
• For details, see steps 1–2 in “Non-

EOS Cameras: Importing Images with 
CameraWindow”.

• If the main ImageBrowser EX window is 
open when your camera/camcorder is con-
nected (for example, immediately after images 
are imported), access the CameraWindow 
menu screen by clicking the [Import/Camera 
Settings] launcher button, and then click 
[Connect to Camera].

Click [Organize Images on Camera] Æ 
[Organize Images].

Click  [Upload] and select images.

• Movies can only be returned to cameras that support files in MOV format. For 
details, refer to the camera user guide.

• Some camcorders do not support returning files to the camcorder.
• It may not be possible to return images after image editing or information modifica-

tion on a computer.

1

2

3
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 Returning Images to Memory Cards
Images imported to the computer can also be returned to your camera, using a memory card 
reader. The images you return can be viewed on the camera.
• EOS Utility cannot be used to return images directly to EOS cameras.

Insert a memory card that has been 
formatted on the camera into the 
memory card reader.

In the main ImageBrowser EX 
window, select images to return to 
the camera.

Click [Import/Camera Settings] and 
choose [Transfer Images to Memory 
Card].

• Only images in JPEG or MOV format can be returned. However, returning MOV files 
requires a camera that supports this format. For details, refer to the camera user 
guide.

• Only DCF-compliant images can be written to memory cards.
• It may not be possible to return images after image editing or information modifica-

tion on a computer.

1

2

3
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Basic Operations in ImageBrowser EX

 Window Elements (Main Window)

Launcher Area
Select tasks to perform.

Tree View
Select folders to view. For 
details, see “Tree View”.

Toolbar
Rotate or delete images, 
or perform other tasks. For 
details, see “Toolbar”.

Browser Area
Rows of images are shown in 
this area.
Icons near images indicate 
image properties. For details, 
see “Properties Icons” below.

Browser Control Bar
Settings governing display in 
the browser area. For details, 
see “Browser Control Bar”.

1

2

3

4

5

 Properties Icons

• The buttons shown vary depending on camera/camcorder model.

 : Images shot in Stitch Assist mode

 :  RAW Images
To view RAW images shot in aspect ratios 
other than 4:3, use Digital Photo Professional 
(p. 36).

 :  Movies

 :  Geotagged images

3

1

2
4

5

Window Elements (Main Window)

Switching Display Modes

Browser Area Tasks

Properties Window: Image Details

Playing Movies
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 Tree View
Imported images are managed on the basis of folders. To view or browse images organized by 
folders, shooting date, or other criteria, click the relevant item (folder) listed in the tree view.
• By default, importing images using CameraWindow will create new folders to store them, named with the 

shooting dates.

Folders
Shows destination folders where images are stored.

Shooting Date
Images organized by shooting date. Browse images by selecting a date 
(year/month/day).

People
People’s names (as assigned to images or acquired from cameras sup-
porting Face ID) are listed here. This area is useful when browsing 
shots of friends, family members, or other people. (Only available with 
cameras supporting Face ID.)

History
Lists a record of operations.

1

2

3

4

• The buttons shown vary depending on camera/camcorder model.

1

2

3

4

Image Storage Location
By default, images imported using CameraWindow are stored in the following location in new 
folders created based on shooting date:

• Windows 7 or Vista: On the C drive in [Users] → [XXXXX] (user login name) 
→ [My Pictures] or [Pictures]

• XP: On the C drive in [Documents and Settings] → [XXXXX] (user login name) 
→ [My Documents] → Stills: In [My Pictures]; Movies: In [My Videos] (may not 
exist in some environments)

On the startup disk (Macintosh HD, for example) in [Users] → [XXXXX] (user 
login name) → [Pictures]

Windows

Macintosh
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Launcher Area
Many tasks in ImageBrowser EX can be done by clicking a launcher button in the main window 
and following instructions in the new window displayed.

Click a desired launcher button.
If a menu is displayed below the button, 
select a desired item. These items may vary 
depending on your model of camera/cam-
corder.

Follow the instructions to complete 
the task.

Import/Camera Settings
Import images or return images to the 
memory card.

Share
Attach images to email messages, or upload 
them to sharing websites.

Launcher Buttons

Edit
Edit images.

Print
Print images.

CANON iMAGE GATEWAY
Use CANON iMAGE GATEWAY services.

Map
View geotagged images on a map. 
(Geotagged shots only.)

• The buttons shown vary depending on camera/camcorder model.

1

2
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 Toolbar
Rotate images and perform other tasks.

Back/Forward
View other folders as needed.

Rotate 90° Counterclockwise/Clockwise
Rotate selected images left or right 90°.
•  To rotate original images to match the appearance of rotated images 

on the screen, right-click images and choose [Rotate According to 
Rotation Info].

Delete
Delete selected images.
Deleted images are moved to the [Recycle Bin] or [Trash] on the desk-
top.

1

2

3

1 2

3

 Browser Control Bar
Settings governing display in the browser area.

Sort
Sort images according to the 
selected order.

Show Image Information
Show/hide the properties icon, 
file name, and shooting date/
time near images in Thumbnail 
mode.

Show Image Properties
Show the properties area, to the 
right of the browser area.

Switch Display Modes
Clicking this button will switch 
among display modes for the 
main window.

 Thumbnail Mode

  Preview Mode

  Full Screen

Fit to Screen
Resize images to fit the window. 
(Only available in Preview mode)

Original Image Size
Show images at the original size. 
(Only available in Preview mode)

Zoom In or Out
Zoom in or out (in Preview 
mode) or resize thumbnails (in 
Thumbnail mode).

1

2

3

4 5

6

7

4 7

1 3 52 6
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 Switching Display Modes
Switch the browser area to a convenient display mode as needed.

Thumbnail Mode:
Browse images by reviewing rows of 
thumbnails at a convenient size.

Preview Mode:
View the current image at a larger 
size while browsing thumbnails.

 Full-screen:
Full-screen display of the current 
image.

Returning to the Original Display Mode from Full-Screen Display
To return to the original display mode from full-screen display, click (for still images) or double-
click (for movies) the current image or movie.

 Browser Area Tasks
You can do the following tasks in the browser area:

• Select Images (Thumbnail Mode)

Click images to choose them.
• To select multiple images, hold down the [Ctrl] key 

as you click each image.

• To select a range of adjacent images, click the first 
image and then hold down the [Shift] key as you 
click the last image.

Convenient Shortcut Menus
Right-clicking a blank area of the screen or an image will display a shortcut menu. The menu 
presents supported and convenient functions in one place. Try using these menus for greater 
efficiency.

Using the Image Navigator
In Preview mode when you zoom in or out, a navigator window is shown to indicate the 
current position. You can change the image area shown by dragging  in this navigator 
window or by clicking in the window.



25CCCCoCoCoCoCoCoCoCo ttntntntntntntntntenenenenenenenentttstststststststs

Advanced Operations Appendix
More Advanced 

Operations
Introduction Basic Operations

  Properties Window: Image Details
To view image properties, select an image in the browser area and click  in the browser con-
trol bar.

Show/hide the information item.

Read-only
Prevent the image from being overwritten or deleted.

Shooting Info Tab
View a brightness histogram, the shutter speed, expo-
sure compensation, and other shooting details.

1

2

3

1

2

3
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  Playing Movies
Movies can be played in Preview mode or at full screen.

Preview Mode

Play the movie, adjust volume.
When viewing super slow-motion movies, 
you can use a playback speed bar and real-
time playback button (  ). Click the button 
to watch the movie at the speed at which it 
was actually recorded.

Trim unneeded scenes at the beginning or 
end.
When viewing movies created in Movie 
Digest mode, you can select unneeded 
scenes and delete them.

1

2

1

2

Returning to the Original View from Full-Screen Display
To return to Preview mode from full-screen display, double-click the current movie.
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Updating the Software and Obtaining New 
Functions

Keep ImageBrowser EX up to date and obtain any new functions that are released as follows.
ImageBrowser EX will automatically check for updates or new functions when your computer is 
connected to the Internet. If a message is displayed regarding installation, follow the instructions 
to install the update.
Use ImageBrowser EX when online to take advantage of auto updating. This feature is not avail-
able when offline.

• The following task requires administrator rights.
• Internet access is required for updates. You must have an account with an Internet 

service provider, a browser must be installed, and an Internet connection must be 
established.

• As with ordinary Internet access, ISP connection or access fees may apply.
• If you cannot use auto updating, visit the Canon website for information about 

ImageBrowser EX updates or new functions.
• If the user guide for your desired software is not updated automatically, download 

it from the Canon website.

 Manually Updating ImageBrowser EX

Click  and choose [Update to latest 
version].

Manually Updating ImageBrowser EX
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 Printing

  Printing Individual Images on a Sheet
Print individual images on single sheets of paper as follows:

Printing Scenes in Movies
Although movies cannot be printed, you can extract, save, and print still images from movies. 
For instructions on extracting still images from movies, see “Extracting Multiple Images from 
Movie”.

Select an image to print, click [Print], 
and then select [Print Images].

1

Printing Individual Images on a Sheet

Printing Contact Sheets
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Complete the print settings as 
desired.

1 4 5

2

3

Specify the printer, paper size, borderless printing 
options, and so on.

Select your preferred printing format for the shoot-
ing date/time.

Specify whether or not to maintain the aspect ratio 
of cropped images when you print them.

Crop images to avoid printing unwanted image 
areas.

Add text to images before printing.

1

2

3

4

5

Click [Print].
The image is now printed.

2

3



30CCCCoCoCoCoCoCoCoCo ttntntntntntntntntenenenenenenenentttstststststststs

Advanced Operations Appendix
More Advanced 

Operations
Introduction Basic Operations

  Printing Contact Sheets
Print rows of images as follows:

Select images to print, click [Print], 
and then select [Print Contact Sheet].

Complete the print settings as 
desired.

Specify the printer, paper size, and other options.

Specify the number of rows and columns.

Configure settings to print details such as shooting 
information, a header or footer, and page numbers.

Select images to rotate or crop.

Rotate selected images.

Crop selected images to avoid printing unwanted 
image areas.

1

2

3

4

5
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1 5 6
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Click [Print].
The image is now printed.

1
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 Organizing Images

Move Images

Changing the Image Sort Order

  Move Images
Move images to other folders as desired.

To move an image to another folder, 
drag the image to the destination 
folder under [All Images] and release 
the mouse button.

• Images will be tagged instead of moved when the 
selected original images are in [Shooting Date], 
[People], or [History] and the destination folder is in 
[All Images]. (In this case, the original images are not 
moved.)

  Changing the Image Sort Order
You can sort images in the browser area according to your selected criterion.

In the browser control bar, click  , 
and in the menu, select the sorting cri-
terion.

Thumbnail Mode

Preview Mode
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 Editing Still Images

<Editing JPEG Images>

Correcting Red-Eye

Adjusting Images Automatically

Adjusting Color and Brightness

Emphasizing Outlines in Images to Increase 
Sharpness

Cropping Images

Adding Text to Images

Using PhotoStitch to Create a Panoramic 
Image

<Editing RAW Images>

Processing RAW Images with Digital Photo 
Professional

 First Steps for All Editing Tasks

In the browser area, select the image 
to edit.

Click the [Edit] launcher button, 
and in the menu, choose an editing 
option.

Follow the instructions displayed to 
complete the task.

1

2

3
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 Correcting Red-Eye
 Restore natural eye color if eyes appear red from the flash firing.

[Edit] Æ [Correct Red-eye]

 Adjusting Images Automatically
 Automatically adjusts image color tone and brightness.

[Edit] Æ [Auto Correct]

 Adjusting Color and Brightness
 Adjust image color tone and brightness using a variety of methods.

[Edit] Æ [Adjust Color and Brightness]

• On the screen displayed next, you can also adjust 
images using a histogram and tone curves.

[Edit] Æ [Adjust Color and Brightness]

[Edit] Æ [Correct Levels]

[Edit] Æ [Correct Tone Curves]

Windows

Macintosh
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 Emphasizing Outlines in Images to Increase Sharpness
 Make images appear sharper by emphasizing the outlines of people and other subjects.

[Edit] Æ [Increase Sharpness]

The Unsharp Mask [Radius] is the 
size at which outlines are detected, 
and the [Threshold] is a reference 
value used to determine outlines.

 Cropping Images
 Crop images to remove unwanted outer portions and leave the desired area.

[Edit] Æ [Crop Image]

• You can also specify the area to crop by entering 
numeric values or specifying an aspect ratio.

 Adding Text to Images
 Add text to images as follows:

[Edit] Æ [Insert Text]

• For smoother text edges, select the [Antialias] check 
box. Text will blend into the background better.

Windows
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 Using PhotoStitch to Create a Panoramic Image
  Create wide panoramic images from a series of shots taken while moving the camera slightly 

before each shot.

[Edit] Æ [Stitch Photos]

If a message is displayed regarding insufficient memory, try the following:
• Close all programs other than PhotoStitch.
• Use fewer images. Reduce the file size of the images.
• On the [Save] tab, select [Adjust image] and specify a smaller size in [Saved Image 

Size].

Using PhotoStitch with Stitch Assist
For images captured in Stitch Assist shooting mode, PhotoStitch can automatically detect the 
image order and merge direction, making it easier to merge the images. (Some models of 
camera/camcorder may not offer Stitch Assist mode.)
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  Processing RAW Images with Digital Photo Professional
RAW images can be converted to JPEG or TIFF format.

In ImageBrowser EX, click [Edit] and 
choose [Process RAW Images].
Digital Photo Professional now starts up.
• You can also start the program by clicking 

the [Start] menu, selecting [All Programs] 
or [Programs], and then selecting [Canon 
Utilities] → [Digital Photo Professional XXX] 
(with XXX indicating the version number) → 
[Digital Photo Professional].

Select the folder where the images 
are saved.

Select an image.

Click  (Edit image window).
The tool palette is displayed.

Using the tool palette, adjust image 
brightness and white balance as 
needed.

• Modification details (information on image process-
ing conditions) are saved as a “recipe” with the 
image.

• In Digital Photo Professional, optimal image adjust-
ment for the scene or subject is possible by specify-
ing a Picture Style.

• Image attributes that can be modified vary depend-
ing on your model of camera.

1

2

3

Tone curves can be used to adjust all RGB chan-
nels at once or each channel individually.

Reduce noise in evening shots or at high ISO 
speeds.

Correct lens aberration in images shot with EOS 
cameras.

Adjust image brightness, white balance, or the 
Picture Style.

Adjust contrast, color tone, saturation, and other 
attributes.

1

2

3

4

5

Tool Palette in Digital Photo Professional

4

1 2 3

5

4

5
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Printing
To print from Digital Photo Professional, select images in the main window and then select the 
desired print function in the [File] menu. The following printing options are available:

Printing Option Description

Print Images are automatically arranged for printing one image per sheet.

Print with detailed set-
ting

Arrange images as desired for printing one image per sheet. Add titles, shooting informa-
tion, and so on, if you prefer.

Print contact sheets Print rows of images on a single sheet. (You can also specify the layout and number of 
images, add text, and more.)

• Shooting RAW images is only possible on cameras that support RAW format. For 
details, refer to the camera user guide.

• Only RAW images supported by Digital Photo Professional can be processed by the 
program. Be sure to refer to the camera user guide.

• A more detailed description of operations is available in the Digital Photo 
Professional Instruction Manual, which EOS camera users can view from the 
included CD-ROM and other users can download from the Canon website.

RAW Images Defined
RAW image files contain the unmodified data captured by the camera image sensor. Unlike 
ordinary JPEG images, the data is essentially “raw” (unadjusted and uncompressed), which 
enables image processing (conversion) on a computer with no loss of image quality.

Image sensor data 
from the shot

Ordinary 
Shooting

Shooting RAW Images
RAW Image

JPEG ImageCompression

Image Adjustment

Compression

Image Adjustment

• Supported by most programs
• Data is already compressed, so image adjust-

ment tends to reduce quality

JPEG/TIFF 
Images

• View and adjust images without loss of image qual-
ity

• Requires processing in Digital Photo Professional 
before viewing with most programs

Camera-Based Image Processing Computer-Based Image Processing

Automatic image adjust-
ment and compression RAW Image Processing in 

Digital Photo Professional
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 Preference Settings

 Configuring Preference Settings
• For details on EOS Utility preferences, refer to the EOS Utility Instruction Manual (provided in PDF format).

ImageBrowser EX

Click  .

Configure settings as desired on the 
Preferences screen.

• With some models of camera/camcorder, custom-
ization may require you to add another destination 
folder. In this case, access ImageBrowser EX prefer-
ences to add a folder.

CameraWindow

Click  .

Configure settings as desired on the 
Preferences screen.

1

2

1

2

Configuring Preference Settings

My Camera: Changing the Shutter Sound and Startup Screen
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 My Camera: Changing the Shutter Sound and Startup Screen
To customize operating sounds and the startup screen used by your camera/camcorder, select 
sounds or screens designed for your model in My Camera settings and assign them to your 
camera/camcorder.

Connect your camera/cam-
corder to the computer to access 
CameraWindow.
• For details, see steps 1–2 in “Non-

EOS Cameras: Importing Images with 
CameraWindow”.

Click [Camera Settings].

Click one of the following options, as 
desired:

Æ [Set Start-up Image]

Æ [Set Sounds]

Æ [Set Theme]

My Camera customization is only available if [Camera Settings] is shown in 
CameraWindow for your camera/camcorder.

[Theme]: Choose to assign the startup screen, 
startup sound, shutter sound, task sound, and 
self-timer sound, collectively.

Current My Camera settings on your camera/
camcorder

Available My Camera settings

Select desired My Camera settings on the right 
and click this button to assign them to your 
camera/camcorder.
If multiple My Camera setting files are shown on 
the left, select a file to replace before assigning 
the new file.

1

2

3
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  Editing Movies

 Editing Movies
Trim movies, combine movies and still images to create an original movie, or edit movies in other 
ways as follows.
You can also add titles or other text, background music, and a variety of special effects.

Select a movie.

Click [Edit] and choose [Edit Movies].

Follow the instructions to complete 
the task.

• Movies you edit this way cannot be returned to the camera.
• Playback of some scenes may not be smooth if you change the frame rate after 

movie editing.
• Saving movies may take some time. In particular, saving movies in MOV format may 

take a long time. Note that the time required may vary greatly depending on com-
puter performance and movie size (resolution).

1

2

3

Editing Movies

Extracting Multiple Images from Movie

Editing EOS Video Snapshot (EOS Cameras 
Only)
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Supported Movie Length
Maximum supported lengths of movies 
you can save are shown on the right. A 
message will be displayed if you attempt 
to save a movie longer than this. In this 
case, trim the movie or reduce the size 
(resolution).
• Movies shot with EOS cameras that 

you edit this way are converted to the 
movie compression format specified by 
ImageBrowser EX before saving. For this 
reason, the movies may be in a different 
movie compression format than specified 
by the camera.

Size (Resolution)
Max. Length (MOV)

23.976 fps/
25 fps/29.97 fps* 50 fps/59.94 fps*

1920 × 1080 Less than 10 min. —
1280 × 720 Less than 20 min. Less than 10 min.
640 × 480 Less than 30 min. Less than 20 min.
320 × 240 Less than 60 min. —

*  On cameras, 23.976 fps is indicated as 24 fps, 
29.97 fps as 30 fps, and 59.94 fps as 60 fps.

Size (Resolution) Max. Length (MP4)
1280 × 720 Less than 30 min.

Trimming Movies
Trim unneeded portions at the beginning or end as follows:

Select a movie in Preview mode.

Click  .

To specify portions to trim, drag each 
end of the bar shown on the left. The 
left point indicates where the movie 
begins, and the right point, where it 
ends.

Click [Save].

• When viewing movies created in Movie Digest mode, 
you can select unneeded scenes and delete them.

1

2

3

4
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 Extracting Multiple Images from Movie
Favorite scenes in movies can be saved separately as still images.

Select a movie.

Click [Edit] and choose [Extract 
Multiple Images from Movie].

Follow the instructions to complete 
the task.

 Editing EOS Video Snapshot (EOS Cameras Only)

Select a video snapshot album.
To confirm that the file is a video snapshot, 
access the properties.

[Edit] Æ [Edit EOS Video Snapshot]
EOS Video Snapshot Task starts up.

• The EOS Video Snapshot Task Instruction Manual 
(in PDF format) can also be accessed from the EOS 
Video Snapshot Task Help.

1
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Other Playback and Image Search

Searching Images by Faces (Face ID-Compatible Cameras Only)

  Searching Images by Faces (Face ID-Compatible Cameras 
Only)

Faces in images are automatically detected when you import images into ImageBrowser EX, and 
the images are sorted into groups by person. Entering personal information in ImageBrowser EX 
enables you to search images by names or nicknames.
• You can also enter personal information on the camera in advance.

Entering Personal Information

Under [People] in the tree view, click 
[Add Person].
A screen for entering personal information is 
displayed.

Unwanted faces can be removed from 
groups by clicking the  in the upper right 
of the face image.

Enter the person's name.
When finished, press the [Enter] key.

Choose an image to represent the 
person, enter a name to display on 
cameras supporting Face ID, and then 
click [OK].

Click [Close].
The added person's name is now listed in 
the tree view.

1

2
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 Protecting Personal Information

• Your camera will store the face images registered using Face ID functions (infor-
mation associated with faces), as well as the personal information (names and 
birthdays). Shots on the camera will also include names of detected people in the 
Exif data. For this reason, after using Face ID functions, be careful when giving the 
camera or images to others, or when posting images online where many people can 
view them.

• For instructions on removing personally identifiable information before you upload 
to sharing websites, see ”Deleting Personal Information Before Uploading to 
Sharing Websites”.

• To delete registered personal information, right-click the person's name in the tree 
view and choose [Delete].

Editing Registered Personal Information
To edit registered personal information, right-click the person's name in the tree view and 
choose [Edit face info].

Searching Images by Faces in Thumbnail Mode

Click a person's name in the tree view.
Images that may include the person are now 
shown in the browser area.
• Images labeled with  in the lower right may not 

include the person. Move the mouse over the frame 
to view the message [Add this person?]. To add the 
person, click  . Otherwise, click  .

Searching Images by Faces in Preview Mode

Select an image with people and 
view it in Preview mode.

Click  in the browser area.
The person's name is now shown under their 
face.
• Names labeled with [?] may not match the 

person. Move the mouse over the frame and 
click [Add this person] or [Do not add this 
person].

• If only [?] is shown in the name box, click the 
box and enter the person's name.

1

2



45CCCCoCoCoCoCoCoCoCo ttntntntntntntntntenenenenenenenentttstststststststs

Advanced Operations Appendix
More Advanced 

Operations
Introduction Basic Operations

Using ImageBrowser EX’s Face ID Data on Cameras
Personal information you enter in ImageBrowser EX can be used by cameras that support Face ID 
to identify people you shoot.

Linking ImageBrowser EX and Camera

• The first time you connect a camera supporting Face ID to the computer, a screen is dis-
played to confirm syncing of personal information. Select [Synchronize automatically].

• Linking is also possible by accessing [Camera Settings] in CameraWindow.

Connect your camera to the com-
puter to access CameraWindow.
• For details, see steps 1–2 in “Non-

EOS Cameras: Importing Images with 
CameraWindow”.

Click [Yes] when a message is dis-
played about optimizing personal 
information on the camera.

1
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Using Online Services, Emailing Images

 Available Services
A variety of online services can be used with ImageBrowser EX. Availability of CANON iMAGE 
GATEWAY services varies by area.

CANON iMAGE GATEWAY
The CANON iMAGE GATEWAY website offers online photo services to Canon camera/camcorder 
customers. After member registration (free of charge), you can share your shots in online photo 
albums and take advantage of many other services.
Visit the CANON iMAGE GATEWAY website (http://canon.com/cig) for the latest information 
on where the services are available around the world. Also check your regional CANON iMAGE 
GATEWAY website to see which services are offered in your area.

• CANON iMAGE GATEWAY Member Registration (Free)

Click [CANON iMAGE GATEWAY] and 
choose [Register/Add Product].

Follow the instructions to complete 
the task.

Registering from the CD-ROM
Member registration is also possible using the included CD-ROM. In this case, click [Register] 
on the CANON iMAGE GATEWAY installer panel.

1

2

Available Services

Using Extended ImageBrowser EX Functions
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• Using CANON iMAGE GATEWAY

Click [CANON iMAGE GATEWAY] and 
choose the desired option.

Using Extended ImageBrowser EX Functions
• Attaching Images to Email Messages

Your shots can be shared as email attachments.

• Uploading Images to Facebook
Your shots can be uploaded to Facebook. (Requires Facebook registration in advance. For details, visit 
the Facebook website.)

• Uploading Movies to YouTube
Your movies can be uploaded to YouTube. (Requires YouTube registration in advance. For details, visit 
the YouTube website.)
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 Using Extended ImageBrowser EX Functions

Attaching Images to Email Messages
Images can be sent as email attachments.

Select an image.

Click [Share] and choose [E-mail 
Images].

Specify the image size and other 
details, and then click [Attach to 
Email].
The default email program now starts up, 
showing the screen for composing your 
message. Images you selected are shown as 
attachments.

• Images will be saved in your designated destination 
folder if you have selected [Save to Folder] under 
[After Finishing the Task] in [Custom Settings].

• If the email program does not start up automatically, 
save the images to your computer before starting 
the program manually, and then attach and send the 
images. Specify where images are saved in [Custom 
Settings], as needed.

In order for your email program to start up automatically, the program must be con-
figured as the MAPI client used on your computer.

Windows

1
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3
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Select an image.

Click [Share] and choose [E-mail 
Images].

Specify the image size and other 
details, and then click [Finish].
The default email program now starts up, 
showing the screen for composing your mes-
sage.
• Images are saved on the startup disk in [Users] 

→ [XXXXX] (user login name) → [Library] → 
[Preferences] → [SendEmailUserData], in the 
[Email Images] folder.

• If the email program does not start up 
automatically, start it manually from the 
[Applications] folder.

Attach the saved images to email 
messages.

Configuring the Email Program for Automatic Startup

• Windows 7: An email program must be installed in advance. To change the 
default email program, click the [Start] menu and select [Default Programs].

• Windows Vista: Configure the settings in your regular email program. For 
example, to configure Windows Mail, start Windows Mail, and in the [Tools] 
menu, select [Options] → [Default Messaging Programs] → [This application 
is not the default Mail handler] → [Make Default].

• Windows XP: Start Internet Explorer, and in the [Tools] menu, select [Internet 
Options]. On the [Programs] tab, specify the program next to [E-mail].

In the [Applications] folder, double-click the [Mail] icon to start Mail. In 
the [Mail] menu, select [Preferences], and then specify the program on the 
[General] tab. 

Macintosh

1

2

3

4

Windows

Macintosh
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 Uploading Images to Facebook: Uploader for Facebook
Upload shots to Facebook as follows. Use images already saved to your computer, or directly 
upload images still on the camera.

Select an image.

Click [Share] and choose one of the 
following options, as desired:

Æ  [Upload to Facebook Album]

Æ  [Upload to Facebook Wall]
Uploader for Facebook now starts up.

Enter a description, and then click  
[Upload].

Enter your Facebook user name and 
password, and then click [Log in].

• Future software operation cannot be guaranteed, in consideration of Facebook 
specifications and changes in specifications.

• It may not be possible to upload images that have been edited on a computer.
• Uploading requires Internet access. You must have an account with an Internet 

service provider, a browser must be installed, and an Internet connection must be 
established.

• As with ordinary Internet access, ISP connection or access fees may apply.

1

2

3

4



51CCCCoCoCoCoCoCoCoCo ttntntntntntntntntenenenenenenenentttstststststststs

Advanced Operations Appendix
More Advanced 

Operations
Introduction Basic Operations

 Uploading Movies to YouTube: Movie Uploader for YouTube
Upload movies to YouTube as follows. Use movies already saved to your computer, or directly 
upload movies still on the camera.

Select a movie.

Click [Share] and then [Upload 
Movies to YouTube].
Movie Uploader for YouTube now starts up.

Enter a title and description, and 
then click  [Upload].

Enter your YouTube user name and 
password, and then click [Log in].

• Future software operation cannot be guaranteed, in consideration of YouTube spec-
ifications and changes in specifications.

• The maximum length for uploaded movies is less than 15 minutes, and the maxi-
mum file size is less than 2 GB.

• It may not be possible to upload movies that have been edited on a computer.
• Uploading requires Internet access. You must have an account with an Internet 

service provider, a browser must be installed, and an Internet connection must be 
established.

• As with ordinary Internet access, ISP connection or access fees may apply.

Uploading Movies on the Camera
Connect your camera to the computer to access CameraWindow. Select [Upload Images from 
Camera] → [Upload Movies to YouTube]. Select a movie to upload on the next screen, and 
then click  [Next] to start Movie Uploader for YouTube. Follow steps 3 and later above.

1

2

3
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 Deleting Personal Information Before Uploading to Sharing 
Websites

Click [Share], and then select a shar-
ing website.

On the next screen, select images in 
[List].

Select [Delete privacy-related infor-
mation (such as people and places)] 
before uploading.
• To delete personal information from all 

images, select [Apply to all images].

1

2

3
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GPS

 Viewing Geotagged Images on a Map: Map Utility
Using geotagged images and GPS logs, you can easily see on a map where shots were taken and 
view the route traveled with the camera.
It is also easy to add or delete location information.

This program uses Google Maps™ to display image locations and routes traveled on a map. 
Location information in images and GPS logs is sent to service providers.

• Uploading requires Internet access. You must have an account with an Internet 
service provider, a browser must be installed, and an Internet connection must be 
established.

• As with ordinary Internet access, ISP connection or access fees may apply.
• Google, Google Maps, and Google Earth are trademarks of Google Inc.
• Geotagged shots and GPS logs may contain personally identifiable information. Be 

careful when sharing the files or posting images online where many people can 
view them.

• Do not use Map Utility with images you are currently editing in Digital Photo 
Professional. This may prevent your changes from being saved correctly.

Viewing Geotagged Images on a Map: Map Utility
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Select an image.

Click [Map].
Map Utility now starts up.

Select a display mode.

Lists the images selected in 
ImageBrowser EX.

Enter a location to find corre-
sponding images.

Click to export location files 
that can be viewed in Google 
Earth. (Use of these files requires 
Google Earth to be installed. 
Note that display may be incor-
rect in some versions of Google 
Earth.)

Add images.

Add or remove image location 
information.

Label images in the current map 
area with landmark names.

Shooting locations are indicated 
by pins on the map.

The current image is shown in a 
pop-up window.

1

2

3

4
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7

8

1

4 5 6

7

8

2 3

Viewing or editing routes

• The buttons shown vary depending on camera/camcorder model.

Map data ©2012 ZENRIN

This Map Utility feature works with images geotagged by cameras with GPS function-
ality or cameras that can use smartphone GPS data.
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Lists GPS log files.

Import GPS log files from a 
camera or memory card.

Add a GPS log file.

Change GPS log time difference 
information.

Remove a GPS log file from the 
list.

Click to filter log information 
display.
Adjust display conditions as 
needed for a better view of the 
route on the map. 

1

2

3

4
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1

3 4 5

Managing GPS logs

• The buttons shown vary depending on camera/camcorder model.

6

Map data ©2012 ZENRIN

This Map Utility feature works with GPS logs recorded by cameras that support logging. 
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 Index

 Importing/Returning Images

“Import images from other cameras/camcord-
ers”
“Import images from EOS cameras”
“Import images from memory card readers”
“Import selected images”
“Return favorite images to the camera”

 Browsing Images

“View images at full screen”
“View movies”
“Check image details”
“Search images by faces”

 Organizing Images

“Organize images into folders”
“Sort image display”

Editing Images

“Edit still images”
“Convert RAW images”
“Edit movies”

 Printing

“Print individual images”
“Print rows of images as samples”

 Other Operations

“Adjust software/camera operation”
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Supported Image Formats
ImageBrowser EX supports the following formats of images shot with Canon cameras or cam-
corders:

Still Images
• JPEG (.JPG)

Image format used by most cameras and camcorders. Images may appear grainy if edited and saved 
repeatedly.

• RAW (.CRW/.CR2/.TIF)
Proprietary image format developed by Canon, designed to preserve digital camera image sensor out-
put, with no loss of image quality. Some cameras may not support this format.

• TIFF (.TIF)
Widely used image format. Supported by many programs in both Windows and Macintosh environ-
ments.

Movies
• AVI (.AVI)

Standard Windows movie format. Files in this format are labeled with a movie icon in the browser 
area of ImageBrowser EX.

• MOV (.MOV)
Movie format. Files in this format are labeled with a movie icon in the browser area of ImageBrowser 
EX.

• MP4 (.MP4)
Movie format. Files in this format are labeled with a movie icon in the browser area of ImageBrowser 
EX.
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Searching for Terms in This Manual
This manual can be read using Adobe Reader. To find instances of specific terms or expressions, 
you can use search functions in Adobe Reader.

Windows

Macintosh Enter the text to find.
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Uninstallation
Uninstall the programs when they are no longer needed, or when reinstalling the programs to 
resolve software issues.
• Uninstallation of ImageBrowser EX is described here as an example. Other programs can be uninstalled the 

same way.

The following task requires administrator rights.

Click the [Start] menu, select [All 
Programs] or [Programs], and 
then select [Canon Utilities] Æ 
[ImageBrowser EX] Æ [ImageBrowser 
EX Uninstall].
The uninstallation process now begins, and 
ImageBrowser EX will be removed from your 
computer.

Drag the [ImageBrowser EX] folder 
(in the [Applications] folder, in 
[Canon Utilities]) to the [Trash].

Empty the trash.

If any folders in the program folder 
contain imported images, be careful 
not to drag them to the trash with 
the program folder.

Windows

1

Macintosh

1

2
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Memory Card Folder Structure
Folders for files used by the software described in this manual are as follows: 

MISC

CANONMSC

GPS

DCIM

Folder containing files for managing images in the 
DCIM folder

yymmddx.LOG (GPS log files)

Folder created when DPOF settings are configured
Contains files for managing DPOF instructions.

One of the 
following:
• xxx_ _ _mm
• xxx_mmdd
• xxxCANON
• xxxEOSxx

•  in file names of sets of images shot in Stitch Assist mode represents a letter, starting with A.
• In GPS log file names (for files in the [GPS] folder), yy represents the last two digits of the year.
• *All folders other than these contain image management files. Do not open or delete them.
• Some image formats may not be supported by your camera/camcorder.

File Name Type of File
IMG_xxxx.JPG Image files in JPEG format
_MG_xxxx.JPG JPEG image files shot in the Adobe RGB color space
IMG_xxxx.CR2 Image files in RAW format
_MG_xxxx.CR2 RAW image files shot in the Adobe RGB color space
IMG_xxxx.CRW Image files in RAW format
_MG_xxxx.CRW RAW image files shot in the Adobe RGB color space
xxxx.TIF RAW image files shot with EOS-1D or EOS-1Ds 

cameras
ST�_xxxx.JPG Image files shot in Stitch Assist mode
MVI_xxxx.MOV Movie files
MVI_xxxx.AVI Movie files
MVI_xxxx.MP4 Movie files
MDG_xxxx.MOV Movie files created in Movie Digest mode

• xxxx represents a four-digit letter or number. 

*
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Troubleshooting

Initial Troubleshooting Tips

Problems and Solutions

Resolve software issues as described in this section.

 Initial Troubleshooting Tips
In case of problems, first check the following points:

• Does your computer meet the system requirements?
Refer to the system requirements in the camera/camcorder user guide.

• Is your camera/camcorder connected to the computer correctly?
For connection instructions, refer to the camera/camcorder user guide.

Also confirm that you are using the correct cable, and that it is firmly connected.

• Are your camera/camcorder and the computer ready to send or receive data?
Some models of camera/camcorder must be in playback mode before data can be sent or received 
from a computer. For details, refer to the camera/camcorder user guide.

• Is there sufficient battery power?
When using a battery-powered camera/camcorder, confirm that there is enough charge left.

When connecting your camera/camcorder to a computer, you can conserve battery power by using an 
AC adapter kit or a compact power adapter (may be sold separately, depending on your model).
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 Problems and Solutions
In case of these problems, try the suggested solutions.

• Cannot find imported images.
 

See “Changing the Destination Folder” and check where images are being saved.

• Add New Hardware Wizard appears when the camera/camcorder is connected to the com-
puter via an interface cable.

Click [Cancel] to close the wizard, and temporarily disconnect the camera/camcorder from the com-
puter. Try to resolve the problem by referring to “Initial Troubleshooting Tips” on the previous page.

• Camera/camcorder not detected, Events dialog/AutoPlay/Device Stage not displayed, Images 
not imported (when the camera/camcorder is connected to the computer via an interface 
cable)

Your camera/camcorder may mistakenly be recognized as another device.

Uninstall the device as follows:

The following task requires administrator rights.

Access [Device Manager].

Windows 7:
Click the [Start] menu and select [Control 
Panel] → [System and Security] → [System] 
→ [Device Manager].

Windows Vista:
Click the [Start] menu and select [Control 
Panel] → [System and Maintenance] → 
[Device Manager].

Windows XP:
Click the [Start] menu and select [Control 
Panel] → [Performance and Maintenance] 
→ [System]. On the [Hardware] tab, click 
[Device Manager].

Windows Macintosh

Windows

Windows

1
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Click [+] next to [Other devices], 
[Portable Devices], or [Imaging 
devices].
Your model of camera/camcorder or [Canon 
Camera] will be listed in these categories 
if the device is mistakenly recognized as 
another device.
• Other factors may be causing the problem if 

[Other devices], [Portable Devices], or [Imaging 
devices] are not listed, or if your camera/cam-
corder model name or [Canon Camera] is not 
listed. Go to step 5 and consider another solu-
tion or try again later.

Right-click on your camera/camcorder 
model name or [Canon Camera], and 
then select [Uninstall].

Click [OK] after the confirmation mes-
sage is displayed.
If applicable, delete all instances of your 
camera/camcorder model name or [Canon 
Camera] listed in [Other devices], [Imaging 
devices], or both categories.

Close [Device Manager] and [System 
Properties].

2

3

4
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ImageBrowser EX User Guide

1  Unauthorized reproduction of this guide in whole or part is prohibited.

2  Information in this guide is subject to change without notice.

3  Illustrations or screenshots in this guide may differ slightly from actual products.

4  Notwithstanding the preceding items, Canon cannot be held liable for any loss arising from the use of 
this software.

© CANON INC. 2012
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